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Overview
MAPI Message Pad is a telephone message system that supplements or replaces the 
traditional "While You Were Out" message pad.    

Message Pad utilizes the E-Mail messaging services (MAPI) provided by Microsoft Windows 
and Microsoft Mail 3.0.    It requires a post office and user accounts created with either 
Microsoft Mail 3.x or the Mail application provided with Windows 95 or Windows for 
Workgroups.    Because of its ability to access the accounts on your existing Mail system, 
Message Pad is very easy to install, use and maintain.    

Message Pad is tightly integrated with Windows E-Mail.    Messages sent with Message Pad 
appear in the Windows 95 and MS Mail InBox and can be viewed either there or in Message 
Pad.    One advantage of this close integration is that you do not need to run Message Pad 
all of the time in order to be notified of new Message Pad messages.    If MS Mail or the 
Windows 95 InBox is running, it will trigger a dialog box which will notify you that you have 
received a new phone message.    (Note: This feature is currently not enabled in Windows 
NT.)

A demo version of Message Pad is available as Shareware.    You can try it for free for 30 
days.    If you continue to use it, you must purchase it.    Message Pad is reasonably priced 
to provide value and to encourage registration. 

Please note that features requiring database functions, including caller search and message
logging, are not enabled in the shareware version.    The additional database files required 
for these features would greatly increase the download size of the shareware version.    
Message Pad uses the industry standard Microsoft Jet database engine, the same database 
that powers Microsoft Access.    This means that the caller search and message log 
databases used by Message Pad can be opened in Microsoft Access for advanced 
searching, sorting and reporting.



Sending Messages
To send a message 

Click the "Compose" button or choose "Compose Message" from the File menu.    This 
clears Message pad and enters the current date and time. 

Enter the name of the recipient of the message in the "To" box    or use the recipient 
pick list.    

Enter the name and phone number of the caller and other pertinent information.    Press 
TAB to move the insertion point to the next box.    Press SHIFT-TAB to move to the previous 
textbox.

Click the "Send" button or choose "Send Message" from the File menu.

When you Send a message, Message Pad checks to see if the recipient is a valid Mail 
account.    If you enter a partial name, for instance the first name only, Message Pad will 
attempt to match that name with an existing account.    If the partial name matches more 
than one account, you will be given the opportunity to select from among the matching 
names.



Recipient Pick List
Message Pad lets you create a pick list of people you frequently send messages to.    Names
can be selected from the pick list by clicking the down arrow button next to the "To" box or 
by pressing the Down Arrow key on your keyboard when the cursor is in the "To" box.

The pick list is also used to autofill the "To" box.    As you type the recipient's name, 
Message Pad will check for matching names in the pick list and will automatically fill in the 
rest of the name for you.

To modify the pick list, select "Recipient Pick List" from the "Options" menu.    This will 
display the "Recipient List" dialog box, which allows you to add or remove names from the 
recipient pick list.    You can add names directly from your Mail Address Book by clicking the 
Address Book button in the "Recipient List" dialog.

The recipient pick list is maintained in a text file named RECIPS.LST in your Message Pad 
directory.    You can change the directory where this file is stored by selecting the Data 
Directory button in the "Recipient List" dialog.



Working With Messages You've Received
Message Pad checks your Mail account for new phone messages at the time interval 
specified in the Preferences Dialog.    You can also direct Message Pad to check for new 
messages by clicking the "Get New" button or selecting Get New Messages from the File 
menu.

When new messages are received, they are displayed in the Pending Messages listbox with 
the following markers:

Messages that have not been read

Messages that have been read

Urgent messages

You can perform the following actions on received messages:
Display the message
Print the message
Forward the message to another person
Delete the message from the Pending Messages listbox
Save changes to the message
Record Followup activities

Print all Pending Messages 



Displaying Messages
To display a message shown in the Pending Messages listbox 

Select the message in the listbox using the arrow keys or single-click on the message 
with the mouse 



Printing a Message
To print a message

Display the message in the message pad

Click the "Print" button or choose "Print Message" from the File menu.

If your printer is capable of printing True Type fonts, the message will be printed with the 
Arial font.    Otherwise, it will be printed using the default font on your printer.



Deleting a Message
To delete a message

Select the message in the "Pending Messages" listbox.

Click the "Delete" button or choose "Delete Message" from the File menu.

Deleting a message also clears the message pad.



Forwarding a message
Any message that you have received can be forwarded to another user.    

To forward a message

Display the message in the message pad

Click the "Forward" button.

Enter the mailbox name of the person to receive the message in the displayed dialog 
box.    When you click OK, the message will be sent.

Before sending the message, Message Pad adds the text "Message Forwarded by [Your 
Name]" to the Note box.    It adds the text "Message Forwarded to [New Recipients 
Name]" to your copy of the message.

You may alter the contents of the message before forwarding it.



Setting Message Pad Preferences
Message preferences and the default Action settings can be changed in the Preferences 
dialog box.    The Preferences dialog box is displayed by selecting "Preferences" from the 
Tools    menu.

Messages Tab
Composing New Messages Tab
Logon/Delivery Tab



Preferences: Messages Tab
The Messages Tab Provides these Options

Check for new messages every 10 minutes (0 = Never)
Beep or play sound file when new message arrives

SoundFile: c:\msgpad\newmsg.wav

Display Pop-Up Dialog for new messages

Confirm before deleting messages  

Launch Message Pad when message opened in Inbox  



Preferences: Composing New Messages Tab
The Composing New Messages Tab Allows You to Select Default Action Settings
The default action settings are the message checkboxes that are automatically checked 
when you select Compose from the toolbar or the File menu.    The default Action settings 
can be changed in the Preferences dialog by selecting new actions and clicking OK.



Preferences: Logon/Delivery Tab
The Logon/Delivery Tab contains these options:

Create New MAPI Session When Message Pad is Started

Force Delivery of Messages



Installation
To install Message Pad using the Setup program

In Windows 95 Click the Start Menu button and choose the Run Command.    In Windows 
3.x,    from Program Managers File menu, choose Run

In the Command Line box, type X:\SourcePath\Setup, where X:\SourcePath is the drive 
and directory where the Message Pad files are located. 

You also must have a post office and user accounts created with MS Mail.    You do not need 
to set up any additional accounts or tell Message Pad who you are.    When you start up 
Message Pad, it will automatically log on to your regular MS Mail account.



Ordering Message Pad
A demo version of Message Pad is available as shareware. You are licensed to use this 
software for 30 days without charge.    If you continue to use it , you must purchase it.

Orders for Message Pad can be placed by completing the Order Form (ORDER.RTF) in your 
MSGPAD directory and mailing it with payment or purchase order to:

Sahalie Software
3320 Harris Street
Eugene, OR    97405

The license fee for Message Pad is based on the number of users, as follows:

5 users $60.00
10 user $100.00

For more than 10 users, the license fee is $45 per every 5 users.    For licenses exceeding 
25 users, please E-Mail a request for a corporate fee schedule to CompuServe ID 
73617,323 or to Internet address bstine@efn.org.

CREDIT CARD ORDERS can be placed through the Public Software Library by calling 800-
242-4775 or 713-524-6394 or by CIS EMail to 71355,470.    THESE NUMBERS ARE FOR 
ORDERS ONLY.    Any questions about the status of the shipment of the order, refunds, 
registration options, product details, technical support, volume discounts, dealer pricing, 
site licences, etc must be directed to Sahalie Software at the address listed above or by CIS
EMail to 73617,323.

5 User and 10 User Licenses for Message Pad can also be ordered through CompuServe's 
Software Registration Database (GO SWREG).        5 User License - ID 1541, 10 User License 
- ID 1544.

Registered users receive a non-shareware version on disk and a printed manual.    
Registered Users are entitled to free upgrades for one year following registration.

© 1992, 1993 Brian D. Stine.    All rights reserved.



Notification of New Messages
Message Pad checks your Mail account for new phone messages at the time interval 
specified in the Preferences Dialog.    If    a new message is received while Message Pad is
minimized, a dialog box pops up over your current application to notify you that you have 
received a new message. 

If Microsoft Mail is running, but Message Pad is not, you will be notified by a popup dialog 
box when new phone messages are received by MS Mail.    (Note: Message Pad must be 
running in Windows NT in order for you to receive the popup notice of new messages.)



Technical Support

Technical support is provided via CompuServe or Internet E-Mail.    Questions should be sent
to CompuServe ID No. 73617,323 or via Internet to bstine@efn.org.    Questions will usually 
be answered on the same day theyre posted.



Phone Dialer
If you have a modem with a phone connected to it, Message Pad will automatically dial the 
callers number for you.    

To dial a phone number, click the telephone button or select "Dialer" from the Options 
menu.    You can set the Com port and modem dial strings by selecting "Setup" from the 
Dialer dialog box.



Saving Messages

To save changes to a message select "Save Message" from the File menu or click the 
"Save" button.    This menu item is enabled only when a message is selected in the 
"Pending Messages" listbox.      



Verifying Mailbox Names
When you send a message, Message Pad automatically verifies the recipients mailbox 
name.    If the name does not match a valid user account, the message will not be sent.    If 
you entered a partial name, for instance a first name only, and the name matches more 
than one user account, you are presented with a list of matching names to choose from.

If you are unsure of the correct    name you can type the first few characters of the users 
name and click the checkmark button next to the "To" box.    Message Pad fills in the rest of 
the name if it is valid or lets you select from among any matching names.



Caller Search
Caller Search uses a database of previous callers to help you fill in the name, company and 
phone number of callers.    Caller Search is activated when you click the Compose button 
(or press CTL-N), and it searches for matches as you type in the callers name.    The first time 
that you select the Compose button in a Message Pad session, you will notice a slight delay
while the Caller Search database engine is loaded.    When the message is sent, Caller 
Search automatically updates its database.    Multiple users can share the same Caller 
Search database.

Caller Search is only available in the registered version of Message Pad.

Caller Search uses the industry standard Microsoft Jet 3.0 data engine, which is used by 
Microsoft Access 7 for Windows 95.    The Caller Search database (usually msgpad.mdb) can
be opened in Access 7 for advanced sorting, searching and reporting.



Recording Follow-Up Activities
To record Follow-Up actions

Display the message

Select the appropriate check marks under the "Follow-Up" heading, e.g. Returned Call, 
Left Message, etc.

The message is automatically saved whenever a Follow-Up checkmark is selected or 
unselected.



New Features in Message Pad 4.0
MAPI Message Pad 4.0 Includes these New Features

32 Bit Version for Windows 95

Improved Message Logging 

Return Receipt Notification

Print List of Pending Messages

FaceLift    for Windows 95 

Other Great Features

Recipient Lookup and Pick List

Message Forwarding improvements

Follow-Up Checkboxes for better message management

Caller Search - available in Registered Version



Starting Message Pad
You can start Message Pad from Program Manager by double clicking the Message Pad icon.

You can also start Message Pad from Microsoft Mail.    There are two ways to start Message 
Pad from Microsoft Mail:

Select "Message Pad" from the Mail menu in MS Mail.

This will start Message Pad or activate the current session if it is already running.    This 
menu item is added to MS Mail when Message Pad is first run for the first time.    If MS 
Mail was running at that time, you need to quit MS Mail and restart it in order for this 
change to take effect.

Open a Message Pad message from Mails InBox or any other Mail folder.

Message Pad messages can be identified in the InBox or other Mail folders by the word 
"PHONE:" at the beginning of the subject line.    By default, Message Pad messages that 
are opened from Mail will be displayed in Message Pad.    This can by changed by 
selecting "Preferences" from the Option menu and unchecking the check box labeled:    
"Launch Message Pad when message opened in Mail."



Message Logging
Message Pad automatically logs all incoming and outgoing messages to a database file.    
By default, the messages are logged to a file named "MSGLOG.MDB" in your Message Pad 
directory.    You can disable message logging or change the name and directory of the 
message log database file by selecting "Data Options..." from the Tools menu, and clicking 
the "Message Logging" tab. 

You can also disable or enable message logging by double clicking the "Message Log" panel
on the status bar.

Messages that you receive are logged when the message is first read.    Note that the 
message must be opened initially in Message Pad and not in MS Mail in order for the 
message to be added to the log file.

To view messages that have been logged by Message Pad, click the Message Log tab on the
main screen.    All logged messages are displayed in reverse chronological order.    To view a 
particular message, click on that message.

The Message Log database (usually msglog.mdb) can be opened in Microsoft Access for 
Windows 95 for advanced sorting, searching and reporting.



 -      Checkmark Button



 -      Rolodex Button



 -      Telephone Button



 -    Unread Messages



 -    Read Messages



 -    Urgent Messages



Messages in Mail Folders
Message Pad messages appear in MS Mail's InBox and can be opened directly from MS Mail.
By default, Message Pad messages that are opened from Mail will be displayed in Message 
Pad.    However, Message Pad messages can also be displayed in Mail, like regular Mail 
messages.    This setting is changed from the preferences dialog.

At times, Message Pad messages are also placed in other Mail folders.    For instance, in MS 
Mail you can choose to save copies of all deleted messages to a Deleted Mail folder.    If you
have selected this option, Message Pad messages that are deleted from Mail will also be 
copied to the Deleted Mail folder.    You may also choose to manually move or copy Message
Pad messages to other Mail folders for archiving or message management.

Messages that have been moved to other folders do not appear in Message Pad's pending 
messages listbox and cannot be viewed in Message Pad.





In the "Check for new messages" box, type how often you want Message Pad to look for new 
phone messages.



If you want Message Pad to notify you audibly when you receive a new phone message, 
check this box.



If your system has a sound card, you can enter a sound file to be played when a new 
message arrives.    A sample sound file called newmsg.wav is provided.



If you want Message Pad to display a popup dialog when you receive a new phone message, 
check this box.



If this box is checked, Message Pad will prompt you to confirm before deleting a message.



Message Pad phone messages are listed in Exchanges and Microsoft Mail's InBox.    If you 
want phone messages to be displayed by Message Pad when they are opened in MS Mail, 
select this checkbox.    If this box is not checked, phone messages will be displayed in Mail 
like any other message.



Preferences: Force New MAPI Session

Create New MAPI Session when Message Pad is Started

By default, Message Pad will use an existing MAPI session at startup.    If you have already 
opened the Windows 95 InBox or MS Mail, Message Pad will not prompt you to re-enter your
user name or password.    However, in Windows 95 you have the option of creating multiple 
Exchange profiles using different E-Mail services.    If this checkbox is selected, Message Pad
will always start a new MAPI session and will allow you to select which Profile to use.    

This feature is helpful if you have, for example, an Internet service provider that is 
accessed through the Windows 95 InBox. When you select Get Messages from Message 
Pads File menu when Force Delivery of Messages is enabled, it will attempt to logon to your 
Internet provider to force the download of messages, which is usually not desired.      One 
solution to this problem is to create an Exchange Profile that only includes the Microsoft 
Mail information service and does not include Internet services.      When you open Message 
Pad and are prompted to logon to Microsoft Exchange, select this Exchange profile.

To create a new profile using only the Microsoft Mail information service:

1. Click the Start button and select Settings/Control Panel

2. Double click on the Mail and Fax icon in Control Panel

3. In the MS Exchange Settings Properties dialog, click the Show Profiles button

4. In the MS Exchange Profiles dialog, click the Add button

5. This will open the InBox Setup Wizard, which will prompt you to select the information 
services to use.    Make sure that the only service that is checked is the Microsoft Mail 
service.    Then click the Next button.

6. Enter a name for the new profile.    Then click the Next button.

7. The Wizard will then take you through several additional steps, including asking you to 
locate the workgroup post office and identify yourself in the list of users.    Follow the 
onscreen instructions.    



Preferences: Force Delivery

Force Delivery of Messages

If this checkbox is selected, Message Pad will force delivery of new messages from your 
Mail server when Message Pad is started and when the Get Messages button is clicked.    
When Message Pad forces delivery of new messages from the MAPI mail system, it will 
attempt to get messages from all information service providers in the current Exchange 
profile.    If you do not want this to occur and do not want to Force a New MAPI Session with 
a new Exchange Profile, then uncheck this checkbox and Message Pad will not force 
delivery of new messages from your Mail server.



Return Receipt
Message Pad provides return receipt capabilities when message logging is enabled.    To 
send a message with return receipt requested, check the Return Receipt Requested 
checkbox at the bottom of the message screen before sending the message.    When the 
message recipient opens the message, a return receipt message will be sent to your 
system.    Message Pad automatically processes the return receipt message.

To view all messages awaiting a return receipt message, click the Return Receipt tab on the
main screen.    To display a message in the Return Receipt list, simply select the message.    
To remove a message from the Return Receipt list, display the message and click the Ignore
button next to the Return Receipt Requested checkbox.

NOTE:    The Return Receipt feature requires that Message Logging be enabled.



Order Form
(To Print this Order Form, Select "Print Topic" from Help's "File" menu)

MAPI MESSAGE PAD 4.0 ORDER FORM

--------------------------------------------------------------------------------------------------------------- 
NAME
---------------------------------------------------------------------------------------------------------------
COMPANY
---------------------------------------------------------------------------------------------------------------
ADDRESS 
---------------------------------------------------------------------------------------------------------------
CITY
---------------------------------------------------------------------------------------------------------------
STATE/ZIP
---------------------------------------------------------------------------------------------------------------
PHONE
---------------------------------------------------------------------------------------------------------------
E-Mail
---------------------------------------------------------------------------------------------------------------

LICENSE FEES

5 user license $60
10 user license $100
More than 10 users $45 per 5 users or contact author for site license

ORDER

                                   Users $                                      

SEND ORDER FORM AND PAYMENT TO

Sahalie Software
3320 Harris St.
Eugene, OR    97405

CREDIT CARD ORDERS

CREDIT CARD ORDERS can be placed through the Public Software Library by calling 800-242-
4775 or 713-524-6394 or by CIS EMail to 71355,470.    

THESE PHONE NUMBERS ARE FOR ORDERS ONLY.    Any questions about the status of the 
shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licences, etc must be directed to Sahalie Software at 
the address listed above or by CIS E-Mail to 73617,323 or Internet E-Mail to bstine@efn.org.



Troubleshooting

How can I force delivery of messages from the Mail server?

When I select Get Messages, Message Pad tries to logon to my Internet provider

Why isn't Message Pad launched when opening a message in Mail under Windows NT?

My phone dialer doesn't work in Windows NT



Print Pending Messages
To print a list of all of your pending messages, select "Print Pending Messages" from the File
menu.



Note to Windows NT Users
This version of MAPI Message Pad requires Windows NT 3.51.    All of the regular features of 
MAPI Message Pad are enabled in Windows NT, except for the following.    We are working 
on correcting these limitations, and updates will be posted as available.

1. The Phone Dialer is not enabled in Windows NT.    Message Pad uses the phone dialer 
services provided by TAPI, Microsofts Telephony API.    Microsoft has not yet released TAPI 
libraries for Windows NT.      When those libraries are available, Message Pad will be able 
to utilize them.

2. Message Pad cannot communicate directly with the Mail client in Windows NT.      
Therefore, we recommend that you leave Message Pad running all of the time in order to 
receive popup notification of new phone messages.    As a consequence of this limitation, 
there is no Message Pad item on the Compose menu.    In addition, when you open a 
phone message in the Windows NT Mail InBox, it does not launch Message Pad.      In 
addition, the Windows NT Mail client will not notify Message Pad of new phone messages 
when Message Pad is not running.    It is anticipated that this limitation will be resolved in 
a forthcoming interim release of Message Pad.




